
A few months ago, as I was preparing this presentation, I sent out a call to the Users 
Group asking for your favorite tips and tricks. I have been collecting these tidbits 
through the years and they have saved me much time and many tears. Since this is 
my final IUG presentation, I wanted to pass these along to you so that you, too, can 
work more efficiently. Throughout the presentation, you will see small blue boxes 
that will point you to the correct search in the Sierra manual for further information. 
There are also some orange boxes along the way giving shout-outs to those users 
who submitted their tips and tricks for this presentation.
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Have you ever encountered a really long contents note or one of those dreaded DVD 
records that goes on for days? You have one word or phrase that you need to edit, 
but you’re bleary-eyed after editing for hours and just need a little help to find what 
you need? There is a Find option just like you find in Word, Excel, or any web-browser.

From the Edit menu, select Find or press Ctrl-F. A Find box pops up where you can 
enter the word or phrase you want to find. It will highlight the first occurrence and 
tell you how many total occurrences appear in the record.
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Macros are available for those repetitive tasks that often involve many key strokes or 
clicks. You can program up to 43 macros using the function keys alone or in 
conjunction with the ALT, CTRL, or SHIFT keys and they stay with the user, not the 
computer. Here are some that I have on my login to handle routine edits such as long 
GMDs that could be easily mistyped. You can program in spaces, arrow keys, and the 
return key along with command keys.
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Kathy Setter submitted these helpful macros if you need to edit a lot of loan rules at 
one time. Use the % sign in front and behind special character combinations so that 
letters are not misinterpreted.
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And this submission from Bob Gaydos has to be one of the longest macros out there. 
Bob designed this one to cut and paste data when editing. As he stated, “A macro 
cannot operate across forms or dialog boxes, but I have been able to jam quite a few 
keyboard moves in there.”
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It’s easy to get stuck in a rut with your display. There are many display settings that 
you can tweak to make your editing experience more rewarding for the type of 
editing you need to do.
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One that has been discussed a lot in recent months revolves around book jackets. If 
you are having problems with your supplier of images, you may want to turn this 
option off temporarily so Sierra responds more quickly. If you have a circulation staff 
member who can’t see the images, you may have forgotten to turn this on when 
setting up their account.
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Another display option that any serious cataloger, especially one who deals with 
authority records, should use is Compact Browse. I use this display extensively, but 
my copy catalogers do not. They like to see the book jackets and I just want to see the 
headings.
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Here is a side-by-side comparison of a compact browse screen on the left and the 
standard browse screen on the right. On the compact browse screen, you only see 
the jacket for the selected record whereas the standard browse displays the jackets of 
all the entries, along with the material type icon.
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As for authority records, with compact browse, it is easy to glance through the names 
listed, see how many entries match, and distinguish the authority records from the 
bibs. We also get a list of the titles associated with the author in the search. With the 
standard browse, it is not clear how many entries match the heading since each is on 
its own line. Although the Source column shows where the entry is within the record 
(a100 for authority name, b100 for bib author), there aren’t any other details to help 
distinguish the entries in the list.
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Have you ever had this happen to you? You start Sierra but nothing shows on the 
screen. Somehow it has reached the end of the Internet and has fallen off the screen. 
Two solutions that date back to 2015 come from Craig Bowman and Ann Mroczenski. 
They suggested a couple of task bar options to move the screen from the pop-up 
preview or to select cascade windows when right-clicking on an empty spot on the 
task bar.
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Beth Juhl offers some Sierra sanity options for the day you upgrade or migrate your 
system. First, block off the entire day as being busy so people leave you alone. If that 
doesn’t work, I’ve added putting your phone on do not disturb and closing your door. 
You should plan to do a lot of testing and know that you will need to open many 
tickets that you will hopefully get to close quickly. And when all else fails … bring 
donuts.
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Who says systems work has to be dull and tedious? Beth also has a good attitude 
about getting staff involved with checking things on the system by encouraging them 
to report bugs that they find. She will then reward them with a small plastic bug of 
some kind. It has become a coveted race to see who has the best bug collection on 
staff.
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Remember that Millennium black box that always seemed to be there and in the 
way? Did you miss it when you upgraded to Sierra? Well, that black box lets you know 
there is some life in the background when it sometimes seems like a response is 
taking forever. It is still there and waiting for you to turn it on. It is also helpful to have 
the Java dialogs that may have been recorded just before the system froze on you or 
crashed. Think of it as the “black box recorder” of Sierra.
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To set up the Java console, go to your Sierra installation folder (generally C:\Sierra 
Desktop App on Windows computers) and edit the iiirunner.lax file. Search for 
console and add the word console to the end of the commands that you see here. If 
you want to record to a file instead of to the screen, use a file save path instead. And 
even though he says he can’t take credit for this tip, I thank Jeremy Goldstein for 
reminding me of it.
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In case you are wondering about the image on the screen, “That Damn Printer” was 
the name of an early IUG program that was videotaped (yes, back before there were 
smart phones and VHS was king) featuring two Innovative staff members recreating a 
typical helpdesk phone call involving printers. Things haven’t changed much in 25 
years and printers are still a problem.

Part of the problem with Sierra is trying to figure out which printer is going to be used 
to print the job in question. To figure this out, Alison Pruntel offers these suggestions: 
bib, item, order, and patron records all use the standard printer. Patron checkouts, 
holds, and fines use the receipt printer. But when in doubt, hover over the print 
button to see which printer is going to be used.
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But wait, there’s more! You may also be using a print template, which is really a 
virtual printer. You may have selected the correct printer, but you still need to select 
the print templates option and check the Save the printer selection to get the results 
to print out properly.
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Adding and deleting location codes are always a challenge. Whenever I need to 
change location codes, I have these resources at hand because of the many tables 
that are affected by adding or deleting just one code. When you add any new location 
to the branch table, remember to restart Sierra to continue with the other table edits. 
Never delete a location code from the branch table until you are sure that code is not 
in use anywhere on your system. Just as you start the add process with adding the 
location to the branch table, the location is removed from the branch table as your 
final step.
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Bob Gaydos suggests that any Sierra administration who is not using a powerful text
editor is no doubt making extra work for themselves. These are his suggested editors 
of choice for manipulating data into submission and the types of edits that he does 
on a regular basis.
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To show the power of these editing tools, Bob sent me this example of adding up to 
200 new item location codes to his system for a new branch. On the left is the 
locations served table for a new branch. On the right is the preparation for adding 
these new codes by using a text editor to manipulate the exported list of location 
codes from another branch. Along with changing the branch prefix for each of the 
codes, he also Prepends each with an “A” for ADD an entry. Admin Corner uses Linux 
so Windows-based text editors will not work properly. Use one of the Unix text 
editors mentioned on the previous slide.
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If you don’t like the constant switching back and forth from keyboard to mouse, get 
familiar with shortcut keys. Most helpful when editing records from a review file or 
browsing catalog or patron records are these. When looking through the records in a 
review file, there is no need to close the record and then click on the next record to 
open it. Likewise, if looking through a summary of records attached to a bib record, 
these keystrokes will save you from constantly closing and opening records. Or, if you 
have a long review file to spot check, highlight one of the entries and then type a 
number to jump to that entry in the list, say, 50, 100, 150 to check every fiftieth 
record.
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If you do edit from a review file, I find it helpful to remove the records that I have 
finished editing as I go so I don’t edit something that is completed and so that I can 
keep my place of where to start the next time. If you are using a list to determine 
whether a missing item should be deleted or just suppressed and you delete several 
items, dedup the list to remove them from the list. I recently had a list of missing 
items and after determining what could be deleted, I deduped the list so I could rapid 
update the suppression fields and add a missing note. Also, when editing from a large 
review file, sort it in several different ways to look at all possible types of codes that 
may be in the records, especially if you are wanting to do a mass deletion of records.
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One search feature that our staff relies on for quick lookups of non-indexed 
information (phone numbers and emails in our case) is Browse Query. This search is 
structured just like Create Lists, except that the results are not saved to a file for 
future use. It is available in Cataloging and Circulation Search/Holds functions. If you 
don’t find exactly what you want and just want to modify your search, that is not 
possible. You will have to start the search from scratch.
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Exporting records from Create Lists can be a bit tricky, especially if you have repeated 
fields or data fields with semicolons or commas in them. These are common 
delimiters for data files and can prove to be time consuming to cleanup if you import 
the data into Excel. Larisa John suggests using the control character “9” as the 
delimiter when exporting to create a perfect tab-delimited file. The reasoning is 
simple – there are no tabs in MARC!
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There have been many suggestions for entering a long list of barcodes into a Create 
List. We do this every month as items are withdrawn from our collection and 
accumulated so they can be mass-deleted after statistics are gathered. The easiest 
way I’ve found is by using the Enhanced tab in Create Lists. The key here is to use “in” 
as the operator. You can scan the barcodes and then click the “+” to add the next 
barcode or you can program your barcode scanner to include the “+” for a totally 
hands-free process. One word of warning with this process. Do not leave a blank 
search line at the end of your list. Doing so will cause your file to fill with records you 
don’t want because the blank search includes ALL values.
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A very popular post earlier this year was offered by Laurie Iffland who shared “The 
Wrangler”. Laurie’s instructions are very detailed on how to manipulate data and 
create a list based on ISBNs or barcodes by using Excel and enhanced and JSON tabs 
in Create Lists.
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Many of our systems have long lists of saved information in Create Lists. It can 
become very unwieldy if saved info is not named in some orderly fashion. My 
suggestion is to come up with a universal naming scheme so that when the saved info 
is sorted, all the like files will fall together. In this example, I named all of my saved 
searches with my initials as the start of the name, so when I sort the list, all my 
searches are clumped together. If you have multiple libraries, I suggest starting the 
name with your library’s abbreviation and then add your initials and then the name of 
the search.
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Just as there are macros for individual record editing, there are macros available for 
global update as well. This takes the power of global update even further as you can 
save the complex update structures for future use. Two options are available: Local or 
Server. Macros saved locally will only be available to the current user. Macros saved 
on the server will be available to all users.
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If this demo was live, it would show the process for loading and enacting a global 
update with a saved macro.
The steps:
1. Create a review file
2. Go to Global Update and select the file
3. On the Command tab, cancel the pop-up “Choose Command” box
4. Select File > Load (Server)
5. Select the saved Macro from the list
6. Edit the Macro if needed.
7. Preview the changes and process the file
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One way to find blank or bad codes in your records is to run a field statistics report. 
But once you see that there are errors in your database, how do you actually find and 
fix them?
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To find the “bad” codes, use the Enhanced tab of Create Lists to search the field in 
question for all the values that aren’t equal to all the valid codes. As you see here, I 
am searching the BDISPLAY field and then anding together all the valid values with 
“not equal to” qualifiers. What will result is a list of records that have some other 
value in the field. How do bad codes happen? Sometimes they are the result of 
deleting a code before all records are deleted or changed.
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The statistics cross-tab report is a powerful tool for finding hidden mistakes. To do 
this, create a list of records that you want to check. Run the cross-tab report on the 
list in the statistics function. Some things to check are regular books coded as 
audiobooks, audiobooks coded as DVDs, DVDs coded as videocassettes, or bib 
locations in the item location field.
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Here is an example from our monthly cataloging statistics. In this example, 1 
reference book was coded as a regular book and 2 paperbacks were coded as regular 
books.
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Using the information in the statistics report, I can create a list based on the errors 
found.
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Once I find the record in question, I can correct not only that error, but also several 
other errors that were found when the record was inspected. The regular book 
template was used instead of the reference book template causing the errors. The 
status should be “o” and the OPACMSG should be “-” in addition to changing the 
itype to 3 for reference book.
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In this resulting record, I added a message to trap this item when it was returned and 
to send it to cataloging so the barcode number can be added to the item record. 
We’re still not sure how it was checked out in the first place without a barcode field!
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Theresa Retzner reminds us of this one that is often forgotten and hidden in the View 
menu. When looking at a record in the SDA, you may want to view it from the public 
webPAC side. From the View menu, select Public Display. It is very helpful during 
cataloging to view what the patron will see. It is sometimes easier to see typos this 
way. Public desk staff have easier access to added webPAC info, such as reviews, links 
to related titles, and book jackets by searching in SDA and then viewing the public 
display.
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Except for the die-hard catalogers amongst us, the Headings Reports can be very 
intimidating. They can become very large and unruly, especially after a large digital 
load with all its dirty data. If you run no other reports, at least run these once a week 
if not daily: Invalid headings, Blind references, Duplicate authorities, and Duplicate 
entries. If you send your headings out for processing on a regular basis, you can 
probably clear the Headings used for the first time report. Otherwise, train your 
catalogers to use Ctrl-g on specific headings when cataloging or Ctrl-h to check all 
headings in the record and fix any headings BEFORE the record is completed. If you 
suspect that there are records that need to be checked, you can force headings to be 
checked by updating a field, usually the suppression field, and then unsuppressing
them.
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Sometimes you may want to check your database for records that are missing a 
crucial field such as bibs without titles or call numbers, patrons with no names, 
orphaned bib records, or deserted records. These types of errors sometimes occur 
when you lose your connection to Sierra, the cataloger abandons one record in favor 
of another, or someone starts to register a patron and they decide to not get a card.
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This little tip is useful when searching all your records to see if a crucial field is 
missing or not. Start with a search for a field that has exists or not exists as its 
condition such as HOLD. Once that is entered, you can then change the field to be 
searched to any field name you want. In this case, I changed it to BARCODE, but you 
could just as easily change it to title or anything else.
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We all have lots of e-resources available in our catalogs these days, but how does a 
patron (or staff member for that matter) know by glancing at the record whether they 
need to use their hoopla, Overdrive, or [insert your other eservice here]? Alison 
Pruntel has solved this one for us. Instead of just having “Click here to access online” 
with the link, tailor the link with the specific service or app name. To do this, create a 
list based on the service and then globally update the records changing the existing 
generic text of “Connect to title online” or whatever you have in subfield z to “Access 
via [service name]”. Your patrons and frontline staff will thank you for your efforts.
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This next tip is one that was new to me. Did you know that you don’t have to only 
view the list of Global Update records one way? Thanks to Swetta Abeyta for pointing 
this one out. With your review file of records selected, right-click on the little toggle 
button at the top right of the display column.
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From the drop-down box that appears, select the field you want to display. You can 
choose from Bibliographic variable or fixed-length fields.
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The new data field and its values now appear on screen. And now that checkbox for 
“Use displayed field” that I always needed to uncheck makes sense! As Swetta added 
in her note, it helps her figure out what is in the fields and decide if she needs to 
update them. Sometimes she will just pull a review file into global update to take a 
closer look at the data.
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And Martha Rice Sanders added this to the toggle option idea – Using global update 
to review records in a review file helps to find odd or missing codes, extra spaces in 
headings, etc., etc.
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Many of our libraries belong to INN-Reach consortiums and with that comes a whole 
bunch of other oddities. This suggestion from Leigh Duncan offers advice on how to 
handle an item that thinks it’s not checked out even though it shows a due date and 
the patron’s info. Open the item record and change the status to @ which is the value 
for INN-Reach off-site. Save the record and try checking it in again. Many times this 
will work, but if it still insists that it is not checked out, you will need to open a 
service commitment to resolve the issue. This process also works when you want to 
delete a record where the link was broken during an INN-Reach cancellation.
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Leigh has also shared her favorite macros to help circulation staff move quickly 
between check-in and check-out without having to use the mouse. You can either use 
the keyboard shortcuts or program 2 neighboring function keys with macros to easily 
switch functions.
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Substitution phrases are one of the most helpful features for repetitive entering of 
data. These are similar to macros but can be programmed for specific modules and 
for use during one session or anytime and all staff can use them. The system-wide 
substitution phrases need to be programmed in Admin Corner using the roadmap 
listed here.
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Our library finds substitution phrases helpful with patron record creation or editing. 
Before we enabled this feature, there were a multitude of variations for the various 
schools in our database and our city name had some creative spellings. Patrons 
would enter anything from abbreviations to the full school name on their card 
applications. It made searching this field nearly impossible. Now staff use the 
substitution phrases during record creation or updating and we have continuity. We 
also use this for the addresses that most of our patrons use. Again, the goal is fewer 
typos and consistency of data entry.
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To make use of the substitution phrase, the staff member enters the code with a % in 
front of it. When the field is entered, the full value is displayed.
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Another way to use the substitution phrase is during full-screen editing. Here the staff 
member right-clicks in the field and selects Substitution Phrase from the menu. The 
staff member selects the substitution phrase they want to use and the full value is 
displayed when the “Use” button is clicked.
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That concludes my tips and tricks that will hopefully help you keep your Sierra Sanity 
in check. And to paraphrase a very wise friend and colleague of mine: Remind your 
staff: Always be nice to your systems administrator. If that doesn’t work, bring 
donuts. Thank you everyone. I will miss all of you in my retirement.
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